Copyright notice

© 2012 General Electric company. All rights reserved.

Confidentiality and proprietary rights

This document is the confidential property of GE and/or its affiliated entities. It is furnished to, and may only be used by, customers and their employees under a written agreement with GE and may only be used in accordance with the terms of that agreement. The access and use of this document is restricted to customers and their employees. The user of this document agrees to protect the confidentiality of the information contained herein and GE's proprietary rights as expressed herein and not permit access to this document by any person for any purpose other than as an aid in the use of the GE software. In no case may this document or any portion hereof be accessed, made available, examined, or copied for the purpose of developing, marketing, or supporting any system or computer program similar to the GE software. No part of this document may be copied without the prior written permission of GE. The information in this document is subject to change by GE without notice.

Inquiries regarding permission for use of material contained in this document should be addressed to:

GE Healthcare IT
ATTN: Centricity Practice Solution Support Manager
540 West Northwest Highway
Barrington, IL 60010
USA

Trademarks

GE, the GE Monogram, and Centricity are trademarks of General Electric Company. All other product names and logos are trademarks or registered trademarks of their respective companies.

Confidential and Proprietary Information. © 2012 The General Electric Company. All rights reserved.

Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>October 2012</td>
<td>M3 released version (rev 4)</td>
</tr>
<tr>
<td>December 2012</td>
<td>M4 General Release version (rev 5)</td>
</tr>
</tbody>
</table>
Centricity Practice Solution is a fully integrated Electronic Medical Record and Practice Management system designed to enhance the clinical and financial productivity of your ambulatory practice. With exceptional customization, progressive technology, and seamless interoperability, CPS enables you to spend more time with patients.

This release includes features that enable clinics to meet Centers for Medicare & Medicaid Services ICD-10 compliance requirements by October 1, 2014, while meeting the needs of clinicians and staff with more intuitive workflows, and easy-to-use features. See “ICD-10 compliance in revenue cycle management” on page 7, and “ICD-10 compliance in clinical workflow” on page 9. For example, with one-click problem entry, problem codes are fully searchable and correlating codes are automatically mapped to both ICD-9 and ICD-10 codes, allowing you to efficiently select diagnosis codes. See “Problem search enhanced” on page 12.

Moving beyond compliance, Centricity Practice Solution offers a welcoming design that includes highly customizable workflows and decision support tools, efficient streamlined navigation, and new and updated features, including enhanced Chart-only license option, and a new Account Summary module for revenue cycle management. See “New Chart-Only license option includes enhanced features for full product” on page 14, and “Introducing Account Summary” on page 4.
How do I learn to use Centricity Practice Solution?

To learn about new features included in this release, read this document from cover to cover. Additional resources and detailed user instructions are available in online help and Adobe PDF guide format for users at all levels, including system administrators, clinicians and staff, clinical content developers, and clinic managers.

For features included in previous Centricity Practice Solution releases, see What's New in Centricity Practice Solution 10x and What's New in Centricity Practice Solution 9x.

Documentation library

The complete documentation library is available as a zipped archive from http://centricitypractice.gehealthcare.com/centricity_library/.

Unzip the file to a folder on your system and make sure that users who need access to library resources can access the network location of the folder.

If you open this guide from the Centricity Document Library or from a library folder copied to your network or a local machine, you can click links to other guides to open them. These links will not work if you copy a PDF to a location outside the library folder.

The following planning and implementation resources are available in this library:

- **System Planning and Requirements for Centricity Practice Solution.** This guide contains an overview of features that impact hardware/software decisions, interfaces, and system planning and maintenance information.
- **Configuring Environments for Centricity Practice Solution.** Detailed hardware and software requirements.
- **Installing Centricity Practice Solution.** This guide contains instructions to install and set up Centricity Practice Solution for the first time.
- **Upgrading to Centricity Practice Solution.** This guide contains instructions for upgrading an existing installation to Centricity Practice Solution.
- **Installing and Maintaining Centricity Clinical Gateway.** Refer to this manual to install and maintain Centricity Clinical Gateway and Cloverleaf, an interface engine that supports certain clinical data exchange features. This is optional software shipped on a separate disc.
- **Calculating hardware requirements for Centricity Practice Solution.** Use this Microsoft® Excel spreadsheet to fine-tune your hardware requirements. If you have 25 or more users, plan to use this tool. The spreadsheet is available in the same folder as this document. When you unpack the zip file, the path is /guides/calculating_hardware_requirements_cps.xls.
- **Managing interfaces with Centricity Practice Solution.** Includes resources to support import and export of clinical data and patient information to and from other systems, such as labs, transcription services, insurance companies, and other healthcare organizations.
Centricity Practice Web site

Go to the Centricity Practice Web site, http://centricitypractice.gehealthcare.com, for access to the following information resources:

- Product updates and service packs
- Integration products and support
- Latest versions of release notes and product documentation
- Product support and services information
- Clinical content and user forums
- Training resources

Online help

When you need a quick answer about using a particular feature in Centricity Practice Solution, online help is your fastest route. Wherever you are in the application, press F1 for relevant help about the task at hand:

- Find conceptual information in Concepts links and Glossary entries
- Follow step-by-step procedures to complete a task

The table of contents, index, search, and glossary can help you learn more about a feature or assist you in troubleshooting a problem or answering a question.

What’s new in this release?

In addition to meeting requirements for ICD-10 compliance, Centricity Practice Solution includes a new Account Summary module and updates to existing features:

<table>
<thead>
<tr>
<th>Summary changes and improvements</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New Account Summary module</strong> provides a centralized location to review account information and troubleshoot patient account status.</td>
<td>page 4</td>
</tr>
<tr>
<td><strong>ICD-10 compliance in revenue cycle management.</strong> View and use ICD-10 codes in all revenue cycle modules.</td>
<td>page 7</td>
</tr>
<tr>
<td><strong>ICD-10 compliance in clinical workflow.</strong> View and use ICD-10 codes in problem lists, custom lists, and encounter forms. Choose the most accurate code at time of visit.</td>
<td>page 9</td>
</tr>
<tr>
<td><strong>Improved Problem Search and Diagnosis workflows.</strong> Now switch easily between ICD-9 and ICD-10 code lists when searching use improved reference list and most frequently used list searching, and intelligent search capability based on commonly-used history that can be filtered by specialty group for order entry and claim entry.</td>
<td>page 12</td>
</tr>
<tr>
<td><strong>New Chart-only licence option</strong></td>
<td>page 14</td>
</tr>
<tr>
<td><strong>LinkLogic and MIK interfaces</strong> support for ICD-10 and other enhancements.</td>
<td>page 19</td>
</tr>
<tr>
<td><strong>New and updated MEL data symbols</strong> support both ICD-9 and ICD-10 codes.</td>
<td>page 22</td>
</tr>
</tbody>
</table>
Introducing Account Summary

Centricity Practice Solution Account Summary provides financial summary information for a guarantor account (total balances and aging) and transaction history with detailed ledger information for each visit within a guarantor’s responsibility.

Account Summary features at a glance

- **Banner** displays guarantor information, alerts related to the guarantor, and patients for whom the guarantor is responsible.
- **Financial Summary** section displays sum of all balances, insurance, patient, and deposit breakdown for all visits with a balance.
- **Aging** section displays aging ranges for guarantor’s outstanding balances.
- **Transaction History** displays all visits for all patients associated with the selected guarantor.
- **Tabs** allow quick access to guarantor information.

Getting started with Account Summary

You can access Account Summary from the main menu, the tool bar, or from an icon within Registration:

Click **View Guarantor Summary** icon to access Account Summary from Registration.
Introducing Account Summary

Configure the Account Summary window to accommodate your workflow and preferences:

- From the Options tab, click Preferences to set user preferences.
- Workstation Settings let you set the display and left navigation buttons.
- Use the left navigation panel arrow to hide buttons you don’t use.

Use File tab to close, logout, and exit:

- Close closes the Account Summary window.
- Close All closes open windows except application main menu.
- Log Out hides all open windows and logs you out of Centricity Practice Solution.
- Exit closes all open windows, logs you out and closes Centricity Practice Solution.

Account Summary user basics

Use Home > Find Patient on Home tab to find the patient guarantor:

- Click Find Patient to select patient guarantor.
Review the guarantor’s associated patients in the banner and the guarantor’s total balance information in the Financial Summary:

Click patient name to view insurance details for a patient.

Financial Summary contains financial information for all patients linked to the guarantor.

View visit information, procedure, and transaction level detail in the Transaction History:

Click toggle icon to expand/collapse all row details.
Click + to expand or collapse a single row.

Dock, undock, or close panels to view multiple records or compare transactions:

- Undocks panel
- Docks panel back to the Account Summary window
- Closes guarantor record

Panel buttons let you undock, dock, and close views

Autohide button hides the panel. The hidden panel appears as a tab.

Select the tab to unhide the panel.

Customize column display. To configure the columns displayed in the Transaction History panel, do one of the following:

- Right-click inside the Transaction History panel, and when the shortcut menu appears, select Customize Columns... The Customize Columns window opens. Configure the columns as needed, and then click OK. To save your changes, Right-click inside the Transaction History panel, and when the shortcut menu appears, select Save Columns.
ICD-10 compliance in revenue cycle management

- Press Alt + C to open the Customize Columns window. Configure the columns as needed, and then click OK. To save your changes, press Alt + S.

Determine what columns to hide or show in the Transactions panel.

Access Help from new Help tab:

New icons assist you in finding the help you need.

ICD-10 compliance in revenue cycle management

ICD-10 codes are now included in the following areas of revenue cycle modules:

- **Practice Management/EMR Systems.** The MIK is updated to accommodate both ICD-9 and ICD-10 code sets for external EMR applications. When charges are imported from the Chart, both ICD-9 and ICD-10 codes are sent from the Chart module. Based on the Visit date, the type of code required on that date is imported into the Visit. This is determined by the date you specify in Administration for ICD-10 only support. See “Administration updates” below.

- **Encounter Forms/Superbills.** CMS 1500, UB 04 and Superbill forms are updated to print either ICD-9 or ICD-10 codes based on the Visit information.

**Administration updates**

- **Filter, search, and display ICD-10 codes.**

Filter and view results by Code Type.
Add, edit ICD-10 diagnosis codes, view related ICD-9 codes. If ICD-9 codes are mapped to an ICD-10 code, up to four related ICD-9 codes will display for the ICD-10 code.

ICD-10 codes appear in updated user interfaces throughout Administration, for example.

Specify date for ICD-10 support. You can specify a date when you are ready to send only ICD-10 codes within the enterprise (on Codes > Settings > ICD-10 Settings). Default setting is October 1, 2014. If all your payers are ready before this date, you can set an earlier date. Any Visit entered on or after the date you set will require an ICD-10 code.
**Visit and Case Management updates**

Improvements to the diagnosis search user interface and workflow are included in the revenue cycle areas. The user can now use a single field to search by either ICD Code, Code, or Description. In the results, the user is able to see related codes of the other version as a learning tool for becoming more familiar with the ICD-10 formats. Based on the Visit date, the system automatically filters for the code type required for the billing date. This is determined by the date you specify in Administration for ICD-10 only support. See “Administration updates” above.

Improvements to the problem search user interface and workflow are included in both the clinical and revenue areas. For more information on problem search, see the section “Clinical workflow and UI changes”.

**ICD-10 compliance in clinical workflow**

In addition to meeting requirements for ICD-10 compliance, Centricity Practice Solution includes updates to existing features. Changes and improvements include the following (detailed in following sections):

- System automatically converts an existing code from ICD-9 to ICD-10 on the Problem list if a one-to-one match is available.
- Users can view Diagnosis Code history (including modifications to codes and whether they were converted from ICD-9 to ICD-10).
- Custom lists are auto-populated with both codes.
- Physicians should choose the most accurate and specific ICD-10 code at time of visit.

**!!! Review your custom clinical content.** Before you start coding problems with ICD-10 exclusively, review your clinical content and update any that work with ICD-9 exclusively.
Updated user interface elements now display ICD-10 codes along with ICD-9 codes, for example in the Chart Summary window:

The same changes appear in the Browser and Mobile Access Client problem pane:

For additional details regarding the support for ICD-10 codes, refer to the section: "Clinical workflow and UI changes".

Clinical workflow and UI changes

In conjunction with support for ICD-10 codes, Centricity Electronic Medical Record contains the following changes in Problems and Diagnosis workflows and the user interface detailed below:

- Problem type qualifier deprecated. This feature is being phased out.
- New search capabilities include quick search, smart list, advanced search, and the ability to easily switch between ICD-9 and ICD-10 codes when searching and sorting.
- Easy conversion of ICD-9 codes to ICD-10 codes. One-to-one match is automatically displayed; or choose from multiple mapped ICD-10 codes that display.
- Codes flagged as non-billable (inactivated) in the billing module are easier to identify in the chart.
- Problem/diagnosis code details are now visible at a glance.
Clinical workflow and UI changes

- Encounter form navigation and Medications workflow has been enhanced.

!!! Often there is not a one-to-one correlation between ICD-9 and ICD-10 codes. You are responsible for selecting the appropriate ICD-10 codes, understanding how they map to ICD-9, and billing accurately.

**Problem type qualifier deprecated**

The problem-type qualifier is being deprecated. This feature is supported for legacy content but unavailable for problems added in this release.

For customers who have upgraded from versions prior to this release, legacy patient problems continue to appear in the chart summary with the qualifier showing and the ICD-9 code, if applicable. However, if a problem with a qualifier showing is edited or reactivated, the problem qualifier is removed from the problem description and is appended to the problem comment.

![Legacy problem appears with qualifier showing.](image1.png)

On Edit, the problem-type qualifier moves from the description to the comments field.

![On Edit, the problem-type qualifier moves from the description to the comments field.](image2.png)

After Edit, the legacy problem-type qualifier appears in parenthesis in the problem description.

![After Edit, the legacy problem-type qualifier appears in parenthesis in the problem description.](image3.png)
**Problem search enhanced**

New quick search for problems provides intelligent search capability that begins searching for codes as the user begins entering the search terms and searches based on commonly-used history or relationships to existing codes and observations. When there are over 60 results for a search term, problem search provides a guided navigation path through folders and subfolders (based on ICD mapping) to allow selection of the most accurate code at the time of the visit. Both quick and full reference searches support the ability to easily switch between ICD-9 and ICD-10 code lists for searching. The new search capabilities appear in the interfaces and workflows for managing Problems, Orders and Medications.

With Quick Search, you can begin typing in the search box, select a problem, and add it to the Problems list:

- The list of matches appears as you type.
- The default uses your preferred custom list.

The smart list feature searches commonly-used history:

- Specify **Smart List** to search terms you commonly use.

Full reference search allows you to drill down and find the most accurate code:

- Select the magnifying glass to search against the full reference list.
- You can select the code from the appropriate ICD list.
**Clinical workflow and UI changes**

**Easier identification of non-billable codes**
All non-billable (inactivated) codes appear grayed-out in Problem Search results. When you search for a code (in new Quick Search or Full Search), codes flagged as inactive or invalid in Billing are gray instead of black.

**Problem/diagnosis code long description from Update Order Details**
A new popup window displays the list of associated diagnoses for the selected order when the user presses Diagnoses... from the Update Order Details window. The list contains the formal description for each diagnosis code.

**Changes in the Encounter form navigation**
Ease of navigation has been improved, resulting from changes to the Encounter form window, including: mouseover highlights, scroll bar resizing, and reordering of Chart menu items.

**Sign and send prescription workflow added**
Users can now sign, print, and send new and changed prescriptions using Sign and Send Prescriptions in the Medications panel.
What’s New in Centricity Practice Solution 11

New Chart-Only license option includes enhanced features for full product

Centricity Practice Solution EMR license option provides access to the charting module without Revenue Cycle management components.

While the following features were added or changed to support the Chart-only version, many are also included in the full licensed version of the application.

Simplified interface hides or disables unlicensed features

The user interface was modified to either hide unlicensed practice management features or to indicate their unavailability. For example, PM module buttons are not visible on the main screen and the PM-specific Edit menu is not accessible.

!!! Once you use the Sign and Send Prescriptions button to sign a pending prescription, you cannot discard the Chart update document.
New Chart-Only license option includes enhanced features for full product

In Registration, PM-only features are also removed or greyed out. PM-only screens are also removed in Administration and Reports.

When Centricity Practice Solution EMR is integrated with a 3rd-party practice management application, users can be prevented from accessing application Registration features by disallowing the relevant permissions. When users do not have permission to enter data in a field, it is disabled and greyed out.

In an integration, features unique to the application registration module are still editable, however, including Get Photo, Home Location of care, Facility, and Contacts. See “New permissions (Chart-only and full product)” on page 15.

**New permissions (Chart-only and full product)**

When Centricity Practice Solution EMR is integrated with an external registration system, fields in Registration are not editable, however the following new permissions let users continue to update fields unique to the application. Users can add information without being granting New patient or Change registration permissions. These permission settings are also available in the full licensed version of Centricity Practice Solution:

- **Change patient contacts.** Allows the user to change a patient's contacts without being granted New patient or Change registration permissions.
- **Change patient home location of care.** Allows users to change the Patient's home location of care without being granted New patient or Change registration permissions.
- **Change patient photo.** Allows the user to change the patient's photo without being granted New patient or Change registration permissions.

If you are upgrading from Centricity Practice Solution 9.5 or later, Change patient contacts, Change patient home location of care, and Change patient photo permissions are automatically set for all users already granted Change Registration permission. If you are upgrading from a pre-9.5 version these permissions must be set manually after the application is updated.
Create facility. Create Facility automatically creates a new Facility when creating a Location of Care. The new Facility is linked to the selected Location of Care. You must have the Create Facility permission.

GE recommend setting up a 1-1 match between facility and location of care.

Changed permission

- Change/complete/remove orders. Beginning in this release, users who modify orders must have this permission in addition to Change Chart. Be sure to grant Change Chart permission to any orders module users who do not already have it.

Added Fax capability to Registration > File > Profile

Use a stored fax number to fax patient registration records to any stored contact (not just patient contacts), including a referring provider, responsible provider, pharmacy, service providers, insurance companies, and other personal contacts and businesses in patient contacts lists.

This faxing capability is in addition to the earlier capability under Registration > File > Profile > Print, which is unchanged.

Registration Facility field

This field displays a default facility if a facility is mapped to the selected location of care. Alternatively, click the binocular icon to search and select facility.
Other enhancements and changes

- **Access Chart from Registration.** Open a patient’s chart Summary from Registration.
- **Registration Chart Contributor option renamed to Chart Access.** All users created on systems licensed for Centricity Practice Solution EMR are automatically set for Chart Access. Additional permissions may be required to contribute to (update) patient charts.

- **System-generated schedule template.** When LinkLogic imports scheduling information for a patient with a provider/resource that does not have an active schedule template, the system automatically creates a template for the given day. No prior setup is required in Administration. System-generated schedule templates cannot be modified in Centricity Practice Solution EMR. The Edit button is changed to View. The time slots for System Generated Template will be for 5mins. See also “Creating appointments” on page 21.

- **ScheduLink import changes.** LinkLogic now processes SIU messages without AIL segment and/or an Appointment Type. See also “Creating appointments” on page 21.

Other enhancements

**New Collections configuration options**

The following new options were added under System > Application:

- Select whether New visits going into Collections are assigned the same collection status of the last visit that was updated when configuring Guarantor-based letters. This applies only to visits related to the same guarantor who has visits in collection status.

- Prevent visits associated to a guarantor with a payment plan from moving to collections even if the visit meets the criteria to automatically move visits to collections.

- When a **Warn if accessing a patient in collections** option is selected, the Collections warning displays only when a patient in collections is accessed in modules other than Collections. The warning is suppressed if the patient is accessed directly from Collections.
Check / rebuild aggregate tables now handled by SQL agent job

The FixAggregates option in Server Setup > Utilities > Run Script File is now a configurable recurring SQL Agent job. The application stores financial information in both dynamic (live) tables and aggregate (pre-calculated) tables. Aggregate tables in certain areas of the product help provide financial information faster. If you encounter a problem in which aggregate financial values do not match live values in your system, you can rebuild the aggregate tables by running this SQL Agent job.

After install or upgrade this job is disabled by default. Enable as you would other SQL Agent jobs (detailed instructions below). By default, the job runs once a week on Saturdays at 5 AM, but you can change this to meet the needs of your organization. Just make sure you set it to run at a time when no users are working on the system. The job can take 10 minutes or longer depending on the size of your database. If a user changes visit information while the job is running, values can become mismatched and you'll need to re-run the job.

If you see a message that the job has failed, contact Centricity Services right away to troubleshoot the cause. It may indicate a problem with your database. When the job fails, the system automatically rolls back and restores indexes and no data is lost, but you need to follow up with Services to completely resolve the mismatch and correct any database problems.

To enable and configure FixAggregates job:

1. Launch SQL Server Management Studio.
2. Go to SQL Agent > Jobs > FixAggregates - <your database name>.
3. Check Enabled below the Job Description.
4. Click Schedules in the left pane.
5. Double-click FixAggregatesSchedule.
6. On the Job Schedule Properties screen, change the frequency and timing of the job as desired.
7. Check Enabled to the right of the Schedule Type list.
8. Click OK to accept the new settings and again to accept Job Properties.
Enhancements and changes to LinkLogic and MIK interfaces

The following changes support exchange of ICD-10 codes when included. See Managing Interfaces with Centricity Practice Solution for detailed descriptions of changes to interfaces and online help for changes to LinkLogic configuration.

**ICD-10 changes to LinkLogic and MIK interfaces**

- **LinkLogic Problems Export** HL7 interface (PPR message) now exports ICD-9, ICD-10, and SNOMED / SNOMED-CT codes in PRB-3 Problem ID fields for diagnoses on patient problem lists.

- **LinkLogic Procedures Export** HL7 interface (DFT message) now exports ICD-9, ICD-10, and SNOMED / SNOMED-CT codes in FT1-19 Diagnosis Code fields for diagnoses linked to orders.

- **LinkLogic Orders Export** HL7 interface (ORM message) now exports ICD-9, ICD-10, and SNOMED / SNOMED-CT codes in DG1-2 Diagnosis Coding Method, DG1-3 Diagnosis Code, and DG1-4 Diagnosis Description fields for diagnoses associated with each order.

**Backward compatibility.** Since the new default is that nothing is exported in DG1-2 or DG1-4, we provide a backward compatibility option for systems that may still need these fields in ORM messages. LinkLogic provides a backward compatibility option to export DG1-2 and DG1-4 using a new Standard Add-On IXP file dg12and4.ixp.

For details see the “Orders Export HL7 interface specification” and “Using IXP configuration files” in Managing Interfaces with Centricity Practice Solution.

- **LinkLogic Clinical Summary Export** HL7 interface (MDM message) now exports ICD-9, ICD-10, and SNOMED / SNOMED-CT codes for diagnoses in the OBX-5 Observation/Result which contains the problems section of exported clinical summary documents.

- **MIK Finance Import** HL7 interface (DFT message) now imports ICD-9, ICD-10, and SNOMED / SNOMED-CT codes (from Centricity EMR or another 3rd-party EMR system) in FT1-19 Diagnosis Code and DG1-3 Diagnosis Code Fields for diagnoses linked to orders.

**MIK ignores SNOMED codes because they are not used for billing, but notes them as an invalid billing code in the Visit Note. Duplicate or unknown codes are also noted.**

If a code type is included with an unrecognized code or multiple matching codes, it is used to determine which invalid code indicator to store in the database. If code type is not included with the code, MIK uses the ICD-9 unknown code indicator ???
**ICD-10 changes in LinkLogic setup**

**Problems Export Constraints supports ICD-10** - Problem SQL filter option is enhanced to let you limit LinkLogic problems export based on ICD-10, ICD-9, and SNOMED / SNOMED-CT codes. See online help for detailed instructions.

In addition to basic Code and Description filtering, you can now use these specific code and description types in your SQL statement to filter for ICD-9, ICD-10, and SNOMED codes.

**Problems Export New Export Job** (Manual) screen displays ICD-9, ICD-10, and SNOMED problem diagnoses codes for a patient to export from the chart.

Where present, both ICD-9 and ICD-10 codes display in patient problems list.
ICD-9-only backward compatibility export constraints option is turned on by default for each of the affected export types (Procedures, Problems, and Orders Export). Uncheck this option when destination systems are ready to receive ICD-10 codes.

Chart-only changes to LinkLogic

The following changes support integration between the Centricity Practice Solution EMR and an external practice management system.

Setting facility

When an incoming HL7 Scheduling message does not contain the facility, LinkLogic uses the facility associated with the provider’s home location of care or the location of care for the scheduled resource.

Creating appointments

For Centricity Practice Solution EMR, LinkLogic uses existing schedule templates or creates and uses them dynamically as scheduling (SIU) messages are received. You need not create templates in Administration in advance before importing messages.

If a schedule template exists for the day for the provider/resource when an HL7 Scheduling message is received, the appointment is created in that template. If no schedule template exists for the day for the provider/resource, then LinkLogic uses a system-generated template. Appointment and slots are created only for the day and date of the imported appointment. There is only one system generated template for each provider/resource.

Appointment Type is optional. If SCH-8 is unspecified, the appointment will be created without any Appointment Type.

While HL7 specification does not require any AI* segments, LinkLogic typically requires both AIG (Doctor/Resource) and AIL (Facility) segments. For the Chart-only version, LinkLogic requires at least one AIS, AIG, or AIP message segment per SIU message, because the doctor/resource is required to create an appointment. The AIL segment is optional.

.IXP files added in this release

.IXP files are used to change how LinkLogic interfaces work. The following files are included in this release. For more information about using .IXP files, see “Using .IXP configuration files” in Managing Interfaces with Centricity Practice Solution.
What's New in Centricity Practice Solution 11

- **abbrevlabfooter.ixp.** Imports an abbreviated form of footer lines at the end of lab report documents for each OBR segment so lab report documents look like test results previously received on paper from Sunquest.

- **abbrevlabheader.ixp.** On import, moves OBR lines from lab footer to an abbreviated form beneath each OBR-sub-heading in lab report documents so lab report documents look like test results previously received on paper from Sunquest.

- **link2.pv1.docloc.ixp.** Root .IXP file that changes PV1-3.4 in ORU Observations Export to include document location of care instead of patient location of care. The location of care for PV1-3.4 is taken from the first document found with observation values to export.

- **obr16sign.ixp.** Exports the order’s signing provider in OBR-16 instead of the order’s authorizing provider.

- **ordinspri.ixp.** Translates the Centricity Practice Solution Insurance order for claims into primary, secondary, or other for IN1-22.

- **pv17sign.ixp.** Exports the order’s signing provider in PV1-7 instead of the patient’s responsible provider.

- **pv119apptid2.ixp.** Populates PV1-19 (Visit Number) with the Appointments ID from an appointment linked to the chart document.

- **labrptheaders.ixp.** Adds header lines with the words OBSERVATION, VALUE, and EXPECTED above the test result lines in imported lab report documents and aligns values beneath in columns.

New, updated and deprecated MEL data symbols

New MEL data symbols include:

- **MEL_CHANGE_PROBLEM.** Changes (edits) information for an active problem on the problem list.
- **MEL_REMOVE_PROBLEM.** Removes a problem from the problem list by changing its active status to inactive.

Updated MEL data symbols include:

- **NEWPROBLEM.** Problem type has been deprecated with the implementation of ICD-10. Although NEWPROBLEM will continue to accept the listed types, the argument will have no effect on the New Problem dialog. For code legibility, use the type DX OF for all future use.
- **PROB_AFTER, PROB_NEW, PROB_PRIOR, PROB_REMOVED.** The list format for the PROB_* symbols was updated to return both ICD-9 and ICD-10 codes, and a problem identifier (PRID). The PRID is a unique number to identify the problem. The PRID can be used by other symbols.
- **ORDERS_AFTER, ORDERS_NEW, ORDERS_PRIOR.** A new Diagnosis ICD-10 field was added to the ORDERS_* symbols. This addition affects how the Diagnosis Description and Diagnosis code fields handle multiple entries.
- **LIST_ASSESSMENTS, MEL_ADD_ASSESSMENT, MEL_ADD_MEDICATION.** Updated to use both ICD-9 and ICD-10 codes.
- **MEL_ADD_PROBLEM.** Problem type has been deprecated with the implementation of ICD-10 and does not appear in the application.

Deprecated MEL data symbols include:

- **GETLONGPROBLEMTYPE.** This data symbol is currently included for legacy purposes and may be removed in a future release.